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1. UVOD

Ovo uputstvo za pisanje maturskog rada je samo tehnicko uputstvo, koje sluzi

da se tehnicki tacno i pravilno napisu maturski radovi, te da budu unificirani za sve

u&enike MSS "Travnik".

Osim ovog tehnickog uputstva, ucenicima je na raspolaganju i metodolosko

uputstvo kojim se propisuje metodologija pisanja maturskog rada, a koje je u skladu

sa pravilima koje se primjenjuju na fakultetima

i u skladu je sa bolonjskim

principima studiranja, a pisano je na osnovu knjige profesora dr Ratka Zelenike

,Metodologija i tehnologija izrade znanstvenog i stru¢nog djela®.

1.1. Prvi korak

Kada zapoc€injete izradu maturskog rada, prvo podesite parametre ,,papir-a“,

odnosno u Page Layout-u podesite margine, veli¢inu papira - size i orijentaciju. Sve

se to moze podesiti u grupi alata Page Layout/Page Setup.

Maturski rad piSe se na racunaru na stranicama formata A4 (210 x 297 mm).

Lijeva margina treba biti Cetiri centimetra radi uvezivanja rada, a ostale margine po

dva i po centimetra. Orijentacija papira je portret.

PrntScr 1: Podesavanje stranica
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1.2. Drugi korak

Nakon papira, potrebno je da podesite Font (u grupi alata Home). Izaberite
font Times New Roman, 12 pt, regular i kliknite na Default,

PrntScr 2: Podesavanje fonta

by
7| Home | msert  pagelayout References

R & Cut

i Il - ind ~
Times NewRoman - 12 Font — 4 " s A Fin
S copy 1 BbCel AaBbecl A S
paste o natpainter | B Z U - sbe %, x Aa-|| % - A -l Font | cherocterpacng | \Bding2  Heading3 = ;:;:Sge e
Clipboard 5 Font i} &5
Eont: Font style: Size: - -
pt, regul|| ‘Times New Roman Regular | 12
- [Tekton Pro Cond - - =
S Tekton Pro Ext Ttalic 9 E|
default. § ;Tempus Sans ITC 10

| |gold
[=]| Bold Ralic 11

[Times New Roman
Traditional Arabic

| Font color: Underline style: Underline color:
| Automatic [ [ (none) = Automatic [~
| ereas
[7] strikethrough [7] Shadow "] small caps
[7] Double strikethrough | Qutline 7] All caps
[7] Superscript 7] Emboss 7] Hidden
[”] subscript 7] Engrave

Preview

Spase

m— e ]
Page:4 of 22 | Words: 1898 <& Bosnian (Latin, Bosnia and Herzegovina) JEEEE
— e

This is a TrueType font. This font will be used on both printer and screen.
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2. TEHNICKA OBRADA NASLOVNICE (KORICE)

Stranica naslovnice maturskog rada treba da u nazivu ima:

MJESOVITA SREDNJA SKOLA ,,TRAVNIK“ U TRAVNIKU

SKOLA

(navesti naziv $kole)

NASLOV MATUSKOG RADA

MATURSKI RAD

TRAVNIK,

(mjesec,godina)

Bez numeracije stranice




PRIMJER NASLOVNICE (KORICE)

MJESOVITA SREDNJA SKOLA ,, TRAVNIK*

OPCA GIMNAZIJA

EMIROVIC EMIR
STRUKTURE PODATAKA | ALGORITMI

MATURSKI RAD

TRAVNIK, MAJ 2015.

Bez numeracije stranice



3.TEHNICKA OBRADA PODNASLOVNICE (POTKORICE)

Prvi unutarnji list maturskog rada sadrzi tekst:
MJESOVITA SREDNJA SKOLA » TRAVNIK*“ U TRAVNIKU

SKOLA

(navesti naziv Skole)

NASLOV MATUSKOG RADA

MATURSKI RAD

Predmet:

Mentor:

Ucenik:

Travnik,

(mjesec, godina)

Bez numeracije stranice




PRIMJER PODNASLOVNICE (POTKORICE )

MJESOVITA SREDNJA SKOLA ,, TRAVNIK*

OPCA GIMNAZIJA

STRUKTURE PODATAKA | ALGORITMI

MATURSKI RAD

Predmet: Informatika
Mentor: Meho Mehi¢, prof.

Ucenik: Emir Emirovié

Travnik, maj 2015.

Bez numeracije stranice

6



4. PISANJE NASLOVA | TEKSTA

Dakle: Naslovnu stranicu rada treba napisati pregledno sa standardizovanim
rasporedom elemenata. Svi elementi naslovnice rada pisu se velikim slovima tipa
Times New Roman, veli¢ine 14 pts, bold stilom, centrirani. Izuzetak je naslov rada
koji se istice 1 piSe slovima veli¢ine 16 pts. Naslovnica se ne numerise.

Elementi podnaslovne stranice rada, takode, se piSu slovima tipa Times New
Roman, veli¢ine 14 pts, bold/normal stilom, i to institucija i oznaka vrste rada
velikim slovima, a podaci o mentoru, predmetu, uc¢eniku, mjesto i datum malim
slovima. Naslov se pise velikim slovima veli¢ine 16 pts. Podnaslovna stranica ne

treba da sadrze nikakve graficke dodatke, niti numeraciju.

Radi postizanja vece preglednosti rada preporucuje se za pisanje teksta
koristiti slova tipa Times New Roman ili eventualno Arial veli¢ine 12 pts. U radu ne
treba mijesati vise fontova. Za isticanje nekih dijelova rada mogu se Koristiti stilovi

odabranog fonta (italic, bold). Fusnote se pisu veli¢inom slova od 10 pts.

Prilikom pisanja naslova 1 podnaslova preporucuje se slijedece:

» Naslove poglavlja (npr.: 1., 2., 3., ...) treba pisati velikim slovima veli¢ine
14 pts, bold. (npr: 1. NASLOV)

= Naslove podpoglavlja sa dvije decimalne jedinice (npr.: 1.1., 1.2., 1.3., ..)
treba pisati malim slovima veli¢ine 12 pts, bold. (npr: 1.1. Podnaslov)

= Naslove podpoglavlja sa tri i vise decimalnih jedinica (npr. 1.2.1, 1.2.1.1.)
treba pisati malim slovima veli€ine 12 pts, italic ili normal podvuceno.

(npr: 1.1.1. Podpodnaslov ili 1.1.1. Podpodnaslov)

» Sve gore navedene naslove treba pisati uvuceno od lijeve margine za pet do
deset slovnih mjesta (1,2 cm).

Tekst se piSe u pasusima, koje je potrebno formulisati i medusobno odvojiti
prilikom pisanja radi postizanja vece preglednosti rada. Prvi redak pasusa uvlaci se
za pet do deset slovnih mjesta udesno od margine (1,2 cm). Broj uvuéenih slovnih
mjesta jedanak je broju uvucenih slovnih mjesta u (pod)naslovu. Naredni pasus pise
se u slijede¢em redu sa uvucenim prvim retkom, bez pravljenja razmaka izmedu
pasusa. Ovakav na¢in pismenog oblikovanja naziva se evropski sistem pismenog

oblikovanja.



Prostor izmedu (pod)naslova dijelova rada i pocetka ili kraja pasusa treba
iznositi najmanje jedan red, bez obzira na primijenjeni sistem pismenog oblikovanja
pasusa. Dobro je da pasus uvijek sadrzi viSe od jedne recenice. Tekst koji Citate

oblikovan je po istim pravilima.

Prilikom pisanja rada na racunaru treba obratiti paZznju na slijededée:

= iza svake rijeci treba biti jedan razmak;

» iza svakog znaka interpunkcije (tacka, upitnik, uzvi¢nik, zarez, dvotacka,
tacka zarez) slijedi jedan razmak;

= znakovi interpunkcije, znak za postotak i sl. piSu se zajedno s rije¢ju ili
brojem iza kojeg slijede, tj. bez razmaka; poslije tih znakova u recenici
slijedi jedan razmak;

= skracenice, mjerne jedinice i oznake valutne jedinice odvojene su jednim
razmakom od broja koji im prethodi i razmakom od rije¢i koja slijedi;

* navodnici na pocetku navoda i otvorena zagrada piSu se zajedno sa rijecju
ispred koje se nalaze, tj. bez razmaka; navodnici na kraju navoda i zatvorena
zagrada piSu se zajedno sa rijecju iza koje se nalaze, tj. bez razmaka;

= ako iza neke rijeci dolazi tekst u zagradi, izmedu te rijeci 1 poCetka zagrade
stavlja se jedan razmak;

= crtica se piSe zajedno s rije¢ima izmedu kojih stoji ako se radi o sloZenici
(Primjer: drustveno-ekonomski), a odvojeno ako se koristi u neku drugu
svrhu;

= skracenice u tekstu piSu se u maloj zagradi nakon navodenja njihovog punog
znacenja, a onda se u daljem tekstu koristi samo skracenica;

» ako se datum piSe samo arapskim brojevima iza svakog broja se piSe tacka 1
ostavlja jedan razmak (npr: 10. 02. 2009.);

» za isticanje pojedinih dijelova teksta preporucuje se koristiti kurziv (italic
stil);

= za pisanje formula preporucuje se upotreba editora formula. Svaka formula
se oznacava malom zagradom u kojoj stoji broj poglavlja i redni broj
formule 1 koja se stavlja uz desnu marginu (npr. 1.5). Za sve simbole iz
formule potrebno je dati objasnjenje, odnosno napisati koju varijablu simbol

oznacava.



5. RAD SASTILOVIMA

5.1. Koristenje stilova je preduslov za automatsko generisanje sadrZaja

PrntScr 4: Rad sa stilovima

R
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Styles ~ || ™

E Styles F E
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Tekst maturskog rada pise su u Normal stilu (to se podrazumijeva)

Za glavne naslove (1. UVOD) potrebno je izabrati stil Heading 1, za
podnaslove (nivo 1.1.Podnaslov stil Heading2, a za podpodnaslove (nivo 1.1.1.
Podpodnaslov) biramo stil Headnig 3. Sva nabrajanja mogu ostati Normal stil, ali po
potrebi nabrajanje treba selektovati i izabrati lijevo poravnanje i neki (bullets) simbol
koji ¢e obiljeziti pojedine stavke nabrajanja, npr (¢ prvi korak.....). MoZe se neki od

ostalih stilova modoficirati samo za nabrajanja.

Sve stilove je potrebno modificirati u skladu sa ve¢ navedenim preporukama

koje su navedene na strani 7. - (desni klik na odredeni stil i klik na modify):
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5.2. Modifikacija stilova

Prilikom modifikacije stilova potrebno je prilagoditi nekoliko parametara:

PrntScr 6: Font i paragraf se modificiraju:
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nasim potrebama.
Boja fontova je uvijek automatic (CRNA), za sve stilove.

Napomena: selektovani tekst poprimit ¢e sve karakteristike stila koji smo

odabrali.
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6. UMETANJE FUSNOTE

Fusnotu insertujemo (umecemo) tako $to se mis pozicionira iza zadnjeg slova

rijeci ili citata, a zatim prelazimo na grupu alata Refernece.

PrntScr 8: Grupa alata References

Home Insert Page Layout ‘ References l Mailings Review  View

[2¢ Add Text ~ AB' gy Insert Endnote S 3 Manage Sources () Insert Table of Figures ‘ lj 12) Insert Index §* 2 Insert Table of Authorities
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Table of Insert o shi | Insert o . Insert i Mark || Mark
Contents ~ | Footnote = SMOWNOIES 1 citation - 4 Bibliography | Caption thiGrass reterence Entry Citation
Table of Contents \ Footnotes IE] H Citations & Bibliography | Captions Index ‘ Table of Authorities
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Izabrati Insert Footnote:

PrntScr 9: Umetanje fusnote
W
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PrntScr 10: Ovdje unosimo fusnotu

!

Na dnu papira se pojavljuje broj i prostor za unos fosnote.
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7. TEHNICKA OBRADA ILUSTRACIJA

[lustracije su sastavni dio rada, a upotrebljavaju se za jednostavnije i sazetije
predstavljanje pojava koje su deskriptivnho obradene u tekstu. Ilustracije koje se
najcesce upotrebljavaju u maturskim radovima su crtezi, fotografije, tablice,
grafikoni i sheme. Svaka ilustracija u radu treba imati svoj redni broj i naslov te
izvor. Redni broj se piSe hronoloski rednim arapskim brojevima nakon oznake za
vrstu ilustracije (na primjer: Tablica 1). Pomocu rednog broja, ilustracija se povezuje
sa tekstom rada tako Sto se nakon teksta u uglastoj zagradi navodi vrsta i redni broj
ilustracije. Nakon rednog broja piSe se naslov koji treba biti kratak, jasan i koji treba
opisati suStinu onoga Sto je predstavljeno ilustracijom. Izvor podataka se navodi

ispod ilustracije prema opisanim pravilima referenciranja. Slijede primjeri:

Tabelal: Navesti ime tabele

rb

Izvor: Istrazivanje autora

llustracija 1. Osnovne komponente informacionih sistema

Osnowne komponente informacionih sistema

O ———
Drustveni kontekst
Procesiipodaci \,
Baze podataka

Haraver

~

/| Telekomunikagje

Metode | tehnike

Izvor: http://informacioni-sistemi.blogspot.com/
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http://informacioni-sistemi.blogspot.com/

8. NUMERACIJA STRANICA

Numeracija stranica vr$i se po pravilu nakon sadrzaja (stanica koja slijedi

nakon sarzaja (1. UVOD) je broj 1. Korica, potkorica i sadrzaj se ne numerisu.

<

gBez
o numeraCIJe
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S Bez
& numeracije

POTKO

e

~

SADRZAJ
S5 W

®

N

umeracije

oy

C

)
©)
>
D
—

Str. br. 1

Nacin da se ovo kreira jest da se ode na vrh Cetvrte stranice i Klikne ispred

pocetka teksta, neka pokaziva¢ ostane tamo, a vi idite na Page Layout -> Breaks i

izaberite Next Page:

PrntScr 11: Razdvajanje dokumenta na sekcije
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Text Wrapping
Separate text around objects on web
pages, such as caption text from body text.

Section Breaks

Next Page

Insert a section break and start the new
section on the next page.

Continuous
Insert a section break and start the new
section on the same page.

Even Page
Insert a section break and start the new
section on the next even-numbered page.

0dd Page
Insert a section break and start the new
section on the next odd-numbered page.

Spacing
b S $Ssefore 6pt :
S 32 Atter 6pt < IR »l
Paragraph

;

dena vrh Eetvite stranice (moZe i dno trece)

i to Back

Arrange

fivag ostane tamo, a vi idite na Page Layout

Text Wrapping = &

PR E CORE

of15  Words: 1432 | %  English (United States)

4 Bring to Front -~ |2 Align ~
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Na ovaj ste nac¢in dokument se podijeli na dva dijela i sada je svaki od njih
moguce posebno uredivati, odnosno upotrijebiti drugaciji sistem numerisanja

stranica.

U nasem primjeru Zelimo da prvi dio dokumenta ne bude numerisan, tj. da
nam naslovnice i sadrzaj budu bez broja stranice. Na drugom dijelu dokumenta, od

uvoda nadalje, Zelimo da broj stranice pocinje od arapskog broja 1 pa navise.

Kako stojimo u ovom drugom dijelu dokumenta, kliknut ¢emo na Insert ->
Page Number i izabrat ¢emo da broj bude na dnu stranice -> Bottom of Page -> Plain

Number 3.

PrntScr 12: Numeracija stranice
1
~— Home | Insert | Page layout References Mailings Review View (7]
| Cover Page ~ ] Ea - & 8, Hyperlink 2 =0 D A |5l Quick Parts ~ |2 Signature Line ~ T Equation ~
M Kl @ E 4 Bookmark \él é I'P@“ A wordart - (5} Date &Time €2 Symbol ~
age

| L] Blank Page
Table Picture Clip Shapes SmartArt Chart Header Footer Text A=
- At - - ~  INumber~!| Box~ ASDropCap~ ‘g Object

'[?‘ Page Break !'m] Cross-reference

Pages Tables Tlustrations Links Header &Fi [®] | Top of Page » kxt Symbols |

‘. < 1| simple ~|[@ Bottom of Page O e G
- Plain Number 1 E| ]  Page Margins >
#] | Current Position >

@-‘ Format Page Numbers...
& Remove Page Numbers

Plain Number 2

penta Kliknuti cemo pa Insert ->
Plain Number 3 | R stranice -> Bottom of Page ->

Plain Number 3
P
e X Number with no formatting or
Accent Bar 1 accents
s
v
433| Save Selection as Page
Page: 16 of 16 | Words: 1.535 | @ English (United States) | BHR == (00
—~— - o 0
B 4 5 = 1
T e mm v " ENSW :

Obzirom da su dva dijela dokumenta i dalje vezana, ovaj drugi dio ne
mozemo oblikovati posebno pa trebamo prekinuti njihovu vezu. To radimo na nacin

da kliknemo na Link to Previous.
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PrntScr 13: Prekidanje veze izmedu dvije sekcije

Home  Insert  Pagelayout  References  Mailings  Review  View | Design [
=o L Ellg] =3 =7 (5 Previous Section | [| Different First Page =1
2 BEEEE g ; [i= =
‘ - 5T} Next Section " Different Odd & Even Pages ‘ =0
ir Footer Page | Date Quick Picture Clip Goto Goto o= : [
~  Number~ || &Time Parts~ Art || Header Footer L@f; nk to Previous | || 9] show Document Text ‘
leader & Footer i Options 1

Insert || Navigation b

0+ 1 110 | 112+ 1 +13

Sada smo prekinuli vezu izmedu dva dijela dokumenta i moramo ponovno
numerirati drugi dio. Za numeriranje drugog dijela kliknut ¢emo na Insert -> Page

Number -> Format Page Numbers.

PrntScr 14: Format Page Numbers

Page Layout References Mailings Review View Design

| B B8

Date Quick Picture Clip
|| &Time Parts~ Art

i Top of Page » a5 __Navigation (| op
a Bottom of Page »
ﬁ @ Page Margins »
[#] | Current Position »
|[§‘ . Format Page Numbers...

L&l R Pane Mumh

Format Page Number

=T 5 Previous Section | [~ Different Fi
T — [ Next Section [7| Different O
Goto Goto \

Header Footer o2 Link to Previous ‘ [#] show Docu

Change the format of page
numbering used in the header or
footer.
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PrntScr 15: Numeracija pocinje od broja 1

L— — —
Home Insert Page Layout References Mailings Review View [ Design @
\% % @ E@ E i 5T, Previous Section || [ Different First Page £+ Header fromTop: ~ 1,25em 3
= E HEl — 55 (5 Next Section I Different Odd & Even Pages | fr Footer from Bottom: 1,25 ¢cm 5
Header Footer Page Date Quick Picure Clip || Goto Goto o = X Close Header | |
v v mber~ || &Time Parts~ At || Header Footer @ Linkto Previous | [¥] Show Document Text [3) nsert Alignment Tab and Footer
Header & Footer Insert Navigation Options Position Close

I3 A2 1123 1A 1516 7§19 1 0 | 111 121 13+ 1 14 B e

Indlude chapter number
Chapter starts with style: \Headmg 1 E |

Use separator: - (hyphen) |~

Examples: 11, 1A
Page numbering
©) Continue from previous section
@ Startat: |1 B

| COE AR RR

| Header Secbon2- | 2. TEHNICKA OBRS

MJESOVITA SREDNJA SKOLA ,, TRAVNIK: JI TRAVNIKU

SKOLA

(osaxsali aaziy. Skele)

Page:30f17 | Words:1.602 | <& English (United States)

e = ®

—
s
>

Rezultat je

PrntScr 16: Numerus 1 je nakon sadrzaja

Footer -Section 2-

\ H;;Jer -Sedionlz-T

Sranicanasiownics matuskogtada reha dau nazivuima:

Jos$ uvijek imamo ukljuc¢eno numeriranje stranica na prvom dijelu dokumenta.
Posto to ne zelimo, selektovat ¢emo ¢emo broj stranice (jednu po jednu), u prvom
dijelu (1, 2 ili 3) i pritisnuti Delete.

Dvostruki klik, bilo gdje u document, kako bismo napustili podnozje (Footer).
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9. AUTOMATSKO GENERISANJE SADRZAJA

Sadrzaj se vrlo jednostavno insertuje (umetne) u dokument ako su koristeni
stilovi Heading 1. 2. i 3. za naslove. Dovoljno je pozicionirati misa na Stranicu iza

uvoda i kliknuti na naredbu Table of Contents iz grupe alata References:

PrntScr 18: Insertovanje sadrzaja

Home Insert Page Layout \ References \ Mailings Review View

[S Add Text ~ UiyInsert Endnote 13 Manage Sources ;
‘ | 2 update Table AB Next Footnote ~ (3 Style: APA Fiftt ~ —
‘ Table of | || Insert Insert Ins)
Contents v ‘ Footnote =| Show Notes Citation » @} Bibliography ~ Capt

J Table of Contents Footnotes ] Citations & Bibliography
of Contents lé T e T R TR A TR A TR AT

= | | )] T L) py: — | Vi

Cont nts click the Add Text button
i entries to the table.

(@ Press F1 for more help.

PrntScr 17: lzaberite Automatic Table 1 ili Table 2

Home Insert Pagelayout | References | Mailings Review View

.1 [ Add Text ~ \1}] Insert Endnote [ 1) Manage Sources |-} Insert Table of F
|4 |3 Update Table A§ Next Footnote ~ (2 style: APA Fiftt ~ ! Update Table
Table of Insert Insert nsert
Contents ~ Footnote =/ Show Notes Citation - 44! Bibliography ~ Caption (] Cross-reference
Built-In rs & Bibliography Captions
|| Automatic Table 1 V030 4| S S ) 8 G 40| e U
g A Mg
1 Contents
2. Heading | 1
Hcading 2 1 -
= 5 AUTOMATSKO GENERISANJE SADRZAJA
Automatic Table 2

1. Table of Contents
2. Heading |

Heading 2

Manual Table

Pagelayout | References | Malings  Review
dd Text * B <ryInsert Endnote l 3 Manage Sou

1 Table of Contents
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10. POPIS LITERATURE

Detalji svih citiranih dokumenata navode se na kraju rada, u dijelu pod naslovom
nLiteratura®. U ovu listu se ne uklju¢uje niti jedan drugi document, izuzev direktno
citiranih/parafraziranih izvora. Literatura se navodi po prezimenima i imenu autora
abecednim redom. Navodi se pored prezimena i imena, naziv knjige, ¢lanka, Casopisa,

naziv izdavaca, godina izdanja i sl. Primjer navodenja literature moze se iz narednog

PrntScr-a

PrntScr 19: Navodenje literature

‘ Home | Insert Pagelayout References Mailings Review View @

& 5 == - &4 Find ~
[3 R |5 FEEBT]| soBbces aaBbea AsBbCA aaBbCC. M = .
|| Sae

Pa_ste ) (n I U ~sbex, X Aa-|[¥- A v|\ E\g = =iz ][& | Emphasis | Heading3  TNomal | Sutite - Change | o

C!ipboald "’ Paragraph Styles || Editing

] O R S S ET T SR R K R T e

1. AlafuzDz:
UGINFOHOUSE, 2007.

2. Bki¢meS. et al: Uy
‘Ekonomski fakultat u Sarsjevy, Sarsjevo, 2006.

3. Klsi¢B.: Rijatanik stranih sijai, Nakladni zavod MH, Zagseb, 2004.

4. Nafdlana kojimase zsmiva Zakon, Pnjadlogzuknmnwmbm
‘obszzovanjuu Bosni i Harcagovini

5. SamiéM.: Kako nastsje: mmd]e‘lo, Zatvrto izdamje, Sarsjevo Svjatlost,
Samjevo, 1977,

6. Olvimi Zak odzojui juuBosni i
‘Hercegovini, usvojen 29. mm sodwe

7. Okvii zak sradrjem Boszii

8. Okrugli
‘omovna kol u Bosni § Harcagovini”, ww. fmon. sov ba. (pristupljano
25.05.2000.)

©. Okvimi i seadnjem juuBiH

10. www.civilnodrustvo, ba/files'g
(pristupljenc 20.05. 2009)

1L

§ —

Cusriculs® Workskop Bokizj, Slovania, 26-28 April, 2002

12. Uputstvo za izrad seminerskog rads Otvoreni Univeritat “Apsison”|
Travnik

13. Uskladivanj odzojui juuBoeni i
ini Odjelaza

‘obrazovanje OSCE-a.
14.Zaleniks R.: i struinog
djsla, Elonomski fakultst u Rijaci, Rijeks, 2000.

NAPOMENA:

Na kraju maturskog rada potrebno je dodati jedan prazan list, na kojem ¢e
mentor i komisija dati svoje misljenje i ocjenu maturskog rada. Na slijedecoj stranici

dat je primjer posljednje stranice maturskog rada.

18



BiljeSka:
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